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June 12, 2008
Dear VERICUT® User:

Thank you for your continued investment in VERICUT, an important part of your NC
programming and machining process!

The VERICUT 6.2 NC simulation, verification, and optimization technology is packed
with new features making it more powerful and easier to use. This letter describes
important changes in VERICUT 6.2. Take a moment to review what's new and improved
in this release.

Maintenance and Licensing Information

[How To Get a License - All users must complete and return the License Request
Form in the CD booklet, or submit the application at
http://www.cgtech.com/usa/support/license/. Licensing is sent via Email only.

NOTE: Use only 6.2 licensing with this software.

Software maintenance keeps you on the cutting edge - CGTech provides update software
to customers with current software maintenance. Your continued maintenance ensures
that you have the most advanced verification technology available. If your maintenance
has expired, please contact your CGTech representative
(http://www.cgtech.com/usa/cgtech/contact/).

Sincerely,
Bill Hasenjaeger
CGTech Product Marketing


http://www.cgtech.com/usa/cgtech/contact/
http://www.cgtech.com/usa/support/license/

VERICUT 6.2

Release Notes
June 12, 2008

VERICUT 6.2 Enhancements
AUTO-DIFF

AUTO-DIFF Surface Range tables are enhanced to include a Range value of 0.00000
which represents surfaces cut exact with no deviation from the design model. A separate
color can be designated for this new Range value.

AUTO-DIFF is enhanced to enable saving the table portion of the AUTO-DIFF report as
a CSV (Comma Separated Value) file format that can be opened as a spreadsheet.

Constant Gouge Check errors, and Minimum Excess errors now turn the Collision status
light red.

The AUTO-DIFF report no longer disappears behind the VERICUT main window when
manipulating the view of the part in the VERICUT graphics area.

The AUTO-DIFF window now has a Result Indicator status light and displays a message
that indicates when errors are detected.

CATIA V5-t0-VERICUT Interface (CATV5)

CATV5 is enhanced to enable selecting CATIA sub-programs.

CATV5 is enhanced to enable retrieving cutting tool descriptions from the CATIA
Resource List.

CATV5 is enhanced to enable selecting a specific tool library, in addition to generating a
tool library from the tools in the current CATIA session, or using the tool library
specified in the setup template.

CATVS5 is enhanced to set the VERICUT Working Directory to the location specified by
"Folder for New Files" in CATVS5.

CATV5 is enhanced to include a "none" choice for Table Name in the Options window.
Selecting this choice causes CATV to create no table entries.

CATV5 is enhanced to enable the entry of a TDM tool list name. A list of TDM tool list
names is not provided.

CATV5 is enhanced to ensure that setups in a CATProcess file have unique names. It will
append "(#)" to the existing names if necessary, where # is the number of the setup in the
sequence, starting with 1.



Machine Simulation

Support is added for simulation of multi-axis water jet cutting operations.

Support is added for simulation of tapping operations, including X-Caliper and
Inspection.

Support is added for the following Siemens 840D commands and features:

SET

REP

DEF STRING with arrays

DEF FRAME including with arrays
ORIRPY

ORIVECT

TOFRAME

Machine Simulation is enhanced to enable orienting the suction cup model on the end of
a moving "pogo" axis, based on how it contacts a workpiece or fixture. The following
POGO-related macros were added to support this functionality:

Pogo

PogoSetMaxAngle
PogoSetAboveTolerance
PogoSetBelowTolerance
PogoCollisionCheck
PogoSetCollisionTolerance

Support is added for the Sin 840D Proc $P_SUBPAR sub parameter transfer flag. No
configuration changes are needed. A local $P_SUBPAR variable will automatically be
created when a Sin 840D Proc statement is processed. The dimensions of the array will
be based on the number of variables define for the current sub. IF subA calls subB, they
will each have their own version of the $P_SUBPAR variable.

Support is added for defining string arrays for Siemens 840D controls.

An Additional Offset feature is added to both the Add/Modify G-Code Table, and the
Add/Modify Machine Table window for defining "relational™ offsets. In addition,
To/From Feature labels have changed from Component and CSYS, to Component Origin
and CSYSS Origin. Their function has not changed.

An all new Drill Cycle method for configuring the Rapid Level, the Part Surface, the
Depth, and the Retract Level is added. In 6.2 it is considered as "experimental™. In
VERICUT 6.3 all sample files will be converted to use the new logic, and the old drill
cycle method interface will either removed, or hidden.



A new feature, Component Visibility, is added to the right mouse button shortcut menu in
a Machine, or Machine/Cut Stock view enables turning on/off the visibility of machine
components. The current machine component visibility settings are now saved in the
project file. When the project file is loaded, the project file visibility settings will override
the visibility settings in the machine file.

A new macro, CircleARParameter, is added to support Siemens 840D AR functions.

New macros, RpcpWithMotion and RpcpContour, are added to control RPCP with
motion and contour like the current RTCP macros.

Support is added for Sinumerik 840D commands SET and REP. Subroutines Sin840D
SET and Sin840D REP are added in Special type (group) with functionality as specified
in Sinumerik 840D manual.

Support is added for Sin 840D G33 SF= Thread offset angle.
Support is added for Tosnuc 888 brackets [ ] to be used in subroutine calls.

A new macro, AutosetTableAxisFrames, is added to enable using pre-defined Work
Offset Tables to initialize frames.

A new macro, SetErrorStatusVar, is added to enable assigning any system variable to
store the most recent error or warning status.

A new parser for supporting Heidenhain MillPlus G29 blocks is available by adding a
G29 word in Word/Format table as Special — Heidenhain IF type. All macros used with
previously implemented support of G29 can be removed from Word/Address table.

Support is added for Heidenhain TNC's Approach/Depart commands APPR LCT and
DEP LCT.

A new conditional function, HeidCondMultiply, is added for word * to support both: *
multiply and * EOB.

New macros, RotaryDirPosCCWADbsolute and RotaryDirPosCWADbsolute, are added to
support absolute rotary direction based on the signed angle and specified direction.

New macros, TablesSubRegisterValue and AutosetTableAxisVarsAdyv, are added to
support for work offset sub-register to allow the definition of sub work offset registers
like G54 J2.

New macros, HeidPointindex, HeidDefinePoint, HeidGotoPointSeq,
SetMultiPointCount, and MultiPointCyclesExecute, are added to support Heidenhain
MillPlus point definition features used for linear motion or drill cycles. The
implementation is only supported for the new drill cycle logic.

New macros, SetPolarinput, SetPolarRadius, and SetPolarAngle are added to support
Fanuc Polar Coordinate commands G15/G16.

A new DEBUG message category: "Active Components” is added to add more debug
information to the G-Code log file to help with the debugging of Multiple Input
channel/multiple spindles machines.

New functions, ISNUMBER and NUMBER, are added to support Siemens function
ISNUMBER AND NUMBER.



New macros, SubroutineNameText and SubroutineNameNumeric, are added to support
the new Fanuc 30 and 31 controls that can call subroutines two different ways.

Macro, WorkingPlane2AbcSolution, is enhanced to provide a general solution for all
WorkingPlane2Abc Types.

A new feature on the View Attributes: OpenGL Settings tab, Course Cut Stock Image,
enables you to control the way that the Cut Stock is displayed, and therefore the
processing speed. When active, the cut stock image in a Machine/Cut Stock view is
displayed as an approximate "block™ image and only updated at the end of each setup.
When active, the cut stock image in a Workpiece view is displayed as an approximate
"block™ image during OpenGL motions (rotate, zoom, pan, etc.).

New macros, RotaryDirShortestDist180CW and RotaryDirShortestDist180CCW, are
added to control rotary direction when the angle is exactly 180 degrees.

Travel Limits in both the G-Code Settings window and the Machine Settings window is
enhanced to include soft limits, step limits, and grouping.

New macro, CycleAxis, is added to enable specifying which axis to use when in a
specific motion plane for cycles.

New macros, FanucDprint, FanucPopen and FanucPclose, are added to support Fanuc
DPRNT external output commands.

The following new macros are added to support Heidenhain MillPlus tangential approach
and exit:

Tangential Angle
TangentialCapture
Tangentiallnit
TangentialMethod
TangentialMovement
TangentialPolar
TangentialRadius
TangentialStartZ

Support is added for Heidenhain iTNC 530 control words "CCA", "RL" and "RR". The
"CCA" word is supported by new macro, TangentialAngle.

New macro, VirtualZAxisDynamic, is added to enable setting a flag which will cause the
VirtualZAxisBRotary to be called after the B axis has been calculated.

The following macros are added to support the simulation of a rivet machine but can also
be used for any application requiring adding or removing model files to a specified
component using macros.

AddModelSetColor
AddModelSetNormals
AddModelSetUnits
AddModelSetFileName
AddModelSetRelComponent
AddModelSetRelPosition



AddModelToComponent
AddModelRemoveAllModels

A new SetCycleSquareOffType, 2, enables moving to the specified XYZ axis position
without any square off before beginning a drill cycle. The implementation is only
supported for the new drill cycle logic.

An all new Drill Cycle method for configuring the Rapid Level, the Part Surface, the
Depth, and the Retract Level is implemented. In VERICUT 6.2 it is considered as
"experimental”. In VERICUT 6.3 all sample files will be converted to use the new logic,
and the old drill cycle method interface will either be removed, or hidden.

New macro, DynamicTool TipOnOff, is added to support dynamic virtual tool tip/control
point when the head rotates.

New macros, ResetCutColor, RepaintCutColor, and SetCutColor, are added to enable
manipulating cut colors using macros.

Support is added for Heidenhain iTNC 530 Cycl Def 5.4 using YZ and ZX motion planes
for pocket cycles. Previously only the XY plane was supported.

An all new "universal™ Ijk2AbcType method for converting tool vector information (IJK
rotary motion data) into ABC rotations is added. New type 99 is intended as a
replacement for methods 5, 8, 9, 10, 12, 14, 18, 20, 21, 22, 23, 25 and 26. In VERICUT
6.2 this "universal” method is considered as "experimental”. In VERICUT 6.3 all sample
files will be converted to use the new logic, and the old methods will become obsolete.

New macro, CompToCompOffset, is added to get the offset vector between any two
machine components.

New Conditionals, HeidCondLeftParen and HeidCondRightParen, are added to support
the conditional use of round brackets on Heidenhain MillPlus controls where "(* and ™)"
can be either be used for indicating a comment, or a mathematical operation.

The ability to use composite Word/Address entries, as a Word - Condition in the
Add/Modify Word Address window is added.

New macros RestrictRotaryAxis and WorkingPlane2AbcVertAxisRule are added, and
existing macro WorkingPlane2AbcSolution is enhanced to support the Siemens 840D
rotary configuration (cycle800).

Macros Probe and Touch are enhanced to return the X, Y and Z coordinates of the
contact point location in the stock coordinate system.

Macros BlockBeginLabel and BlockEndLabel are added to support Siemens 840D
CYCLED9S5 start-label and end-label.

A new macro, AbsoluteShiftRotationDynamic is added to support Heidenhain MillPlus
control's G93 offset which is based on a rotated working plane.

MDI action is enhanced. As long as the stock remains uncut, you can switch between
setups and use MDI in any setup as long as the MDI actions do not cut the stock. All
MDI actions are reset after switching from one setup to another. Once the stock is cut,
MDI use is restricted to the setup where the cut stock resides.



New macro HeidReturnFromSubCall is added to distinguish whether a "PGM™" is being
called or a "LBL" is being called.

NX-to-VERICUT Interface (NXV)
(formerly known as the Unigraphics-to-VERICUT Interface (UGV))

NXV is enhanced to enable removing Program Groups that you do not want to export to
VERICUT. A Remove button is added to the Program Groups window. When you press
the Remove button, any selected program groups are removed from the window, and will
not be not be transferred to VERICUT. A Switch button is also added to enable switching
between displaying active, and removed, program groups. You can select program groups
from the list of those removed, and restore them to the active list by pressing the Restore
button. Removed program groups are saved with the NX part.

NXV is enhanced to support NX5.

NXV is enhanced to enable NXV to query the Geometry in NX to identify the CSYS
names and add them to a pull down list for the "Program Zero To CSYS" on the Options
menu. This will eliminate the need for entering the CSYS name.

The NXV Option window is enhanced to enable selecting the Program Zero to CSYS
entry from a pull-down list of MCS's defined in the NX Geometry View.

A new NXV window feature, Merge Tools with Setup Template, will merge the tool
library created by NXV, with the tool library file stored in the Setup Template, and use
the "merged" tool library rather than one created by NXV.

NXV no longer requires specifying Model Location CSYS before selecting the
operation's geometry (Part, Stock/Blank and Fixture/Check). Part, Stock/Blank,
Fixture/Check, and Model Location CSYS can now be specified in any order. When the
Output Files button is pressed, the Part, Stock and Fixture files for each setup are output
using the last CSYS selected for that setup.

NXV is updated to correctly handle NX's updated format for turning TLDATA
statements of the form:
TLDATA/TURN,LEFT,OUTSIDE,0.0620,1.2500,5.0000,5.0000,6.0000,270.0000

Support is added for TLDATA/GROOVE, LEFT/RIGHT, OUTSIDE/INSIDE, w, r1, r2,
d, al, a2, hh, hw in an NX CLS file.

NXV is enhanced to transfer the Output Directory specified in the NXV interface to
VERICUT as the Working Directory.

NXV is enhanced to transfer tools defined as a "reamer" in NX5 to VERICUT.



OptiPath

OptiPath now outputs a warning message when optimization is suspended because a 2D
Rotation is turned on.

OptiPath is enhanced to report exact cutting depth and width in most standard scenario
cuts. In some cases (for instance, when the tool contact area is irregular or motion is at a
steep angle to the tool axis) the results are still going to be approximate.

When G-Code Settings window feature Apply Acceleration to Cycle Time is active,
optimized NC program files must be used to obtain accurate time estimates. The warning
message, "With Apply Acceleration to Cycle Time enabled you must run optimized files
to get the correct time estimate.” is now issued to remind you of this.

The OptiPath Add/Modify window is enhanced to enable adding the number of teeth that
the cutter has to the OptiPath record.

New macros, FeedTime and FeedTimeMin, are added to enable OptiPath to support
feedrate modes used in controls like OSAI CNC 10 Standard, where the feedrate register
is "T", the value is in seconds, and T1.0000 means 1 second/block.

The OptiPath Add/Modify window is enhanced to update when a new OptiPath record is
selected in Tool Manager. It is also enhanced to no longer disappear behind Tool
Manager and the VERICUT main window when a new OptiPath record is selected in
Tool Manager.

Tool Manager

A new Turret Setup window is added to Tool Manager to enable you to easily load, or
change tools, or change tool positions in a turret.

Tool Manager is enhanced to enable describing the shape, position, and orientation of a
Water Jet component in a water jet tool assembly.

Tool Manager is enhanced to enable describing the shape, position, and orientation of a
tap component in a tap tool assembly.

Tool Add/Modify windows for turning inserts is enhanced to enable graphical selection
of the insert's driven point.

Tool Manager is enhanced to help differentiate between tool different tool assemblies.
The tool row in both the tree and the table are now displayed in bold font.

Tool Add/Modify windows for defining tool components are enhanced to enable adding a
tool component ID at the time that the component is created.

Milling Tool Wizard is enhanced so that it no longer requires XYZ coordinates for
defining the Gage Point and the Driven Point. If only one value is entered, it is applied to
Z coordinate.



Tool Manager is enhanced to support calculations in the Gage Point and Orientation
fields.

Tool Manager performance is enhanced to enable faster Open, Save, and Save As of tool
library files.

Tool Manager is enhanced such that when importing a pre-V6.0 OptiPath library file
(.olb), that is not associated with a tool library but contains tool information created using
the OptiPath Cutter Shape feature, Tool Manager will automatically create tools based on
the STANDARD_CUTTER, PROFILE_CUTTER, and TLS_FILE, TOOL_ID records in
the OptiPath library file.

Verification

Support is added for HyperMill's dynamic mouse view buttons.
e right mouse button = rotate
e Ctrl + right mouse button = pan
e Shift + right mouse button = zoom.

Support is added for EdgeCAM's dynamic mouse view buttons.

e mouse wheel = zooming in/out
e hold mouse wheel down + move mouse = pan
e right mouse button = rotate

A new set of utilities is added to the Info > NC Program window.

e A Calculator window is added to enable mathematical calculations and
conversions from inside VERICUT

e An NC Program Colors window is added to enable specifying colors for specific
features (comments, variable, macros, etc.) in the NC program listing.

e A Block Renumber window is added to enable renumbering part, or all, of the NC
program listing based on a user defined set of criteria.

e A Check Syntax window is added to enable checking the NC program displayed
in the NC Program (Info) window for syntax errors based on a user defined set of
criteria. This feature is also accessible from the NC Program Review editor.

VERICUT is enhanced to support the following Siemens 8MC control type of blocks:

RO1 10 RO2

RO1 -10-R02

R50 0 R58 0

R51 1 R58 0 R59 0 R60 360 R61 2 R57 0

The Info > NC Program window is enhanced to provide access to the new NC Program
Preview feature, describe below.



The Info > NC Program window is enhanced to enable inserting NC blocks from the NC
Blocks List, in the MDI window, into the NC program displayed in the NC Program
(Info) window. You have the option of inserting selected blocks, or all blocks, displayed
in the MDI window.

A new Merge In-Process file feature is added to enable loading an In-Process file without
removing the current project from the VERICUT session. This feature enables creating
multi-setup project files, one setup at a time, without the need to reprocess previous
setups.

A new Call Stack window is added to enable tracking information like subroutine calls,
the subsystem that is currently active, NC program information, etc.

Icons for common standard view layouts are added to the tool bar.
A Mixed Mode icon is added to the tool bar.

The Save ... (Project, In-Process File, Machine, Control) icons in the toolbar are
enhanced to toggle between "Save" and "Save As" by clicking with the right mouse
button.

A new Turret Aid window is added to the Modeling window: Component Attributes tab
to enable easily creating a swept solid model of a turret.

A new Setup Plan window is added to enable adding dimensions or notes to, or edit
existing dimensions or notes in, a setup plan. The dimensions are placed on a plane
(referred to as "the glass") parallel to the view that the setup plan record is associated
with. The user defined setup plan can then be output in a VERICUT report.

A new Machine Notes tab is added to The Machine Settings window to enable adding
Message Notes and Comment Notes to the machine file. Message Notes are saved in the
header of the machine file and are displayed in the VERICUT message area (Logger)
when the machine file is loaded. Comment Notes are saved in the header of the machine
file but do not display in the VERICUT Logger.

A new Control Notes tab is added to the Control Settings window to enable adding
Message Notes and Comment Notes to the control file. Message Notes are saved in the
header of the control file and are displayed in the VERICUT message area (Logger) when
the control file is loaded. Comment Notes are saved in the header of the control file but
do not display in the VERICUT Logger.

A new Syntax Check tab is added to the Word format window to enable turning On/Off
VERICUT defined syntax checking rules (error conditions) and to define custom syntax
checking error conditions for checking the statements in your NC program file for valid
syntax.

The NC Program Review, NC Program listing area is enhanced to provide access to new
utilities ( Calculator, NC Program Colors, Block Renumber and Check Syntax), described
above for the Info > NC Program window. It is also enhanced to provide access to the
new NC Program Preview feature, describe below.

A new NC Program Preview feature puts VERICUT in NC Program Review mode
except that it displays a tool trace representing the NC program and the design model.



This feature can be used without processing the NC program first, as required by NC
Program Review. All of the VERICUT features behave the same as they do for NC
Program Review.

The Project Tree window now opens fully expanded.

VERICUT is enhanced so that the design model moves with the cut stock model as it
transitions between setups. It also moves with the cut stock model when the cut stock is
manually moved via the Modeling window.

VERICUT is enhanced to support milling on turning stock and is considered a valid
cutting operation for any tool/stock orientation (on-center, or off-center). Material is
removed by the tool trajectory volume which is revolved around the stock turning axis.
Full VERICUT support for such motions is implemented (X-Caliper, .vcs files, Model
Export etc.).

A new Help > License feature provides information about License Server Host Name,
total number of each VERICUT feature license that is available on the license server,
license expiration date, total number of each VERICUT feature license that is currently in
use and VERICUT feature licenses being used in the current session.

The cut-stock’s visibility can be changed via the Modeling window's "Visible" toggle.
This change only affects the display of the cut-stock. It does not affect cutting,
simulation, collision detection, picking, etc.

The VERICUT Log file is enhanced to report in the Tool Summary the percentage of
time that each tool spends cutting air.

VERICUT is enhanced to reduce the amount of time (approximately 30% improvement)
required for refine display on very small sections of very large parts.

The Save In-Process As window is now accessible by a right-mouse clicking on the
Saved IP File branch in the Project Tree.

A new Reduce Triangles feature is added to the STL Output window. When unchecked,
the STL file is created using the original STL output (as found under Model Export), with
no triangle reduction. A Model Export license is not required. When checked, the STL
file is created using the triangle reduction method as in VV6.1. The state is saved in the
project file as a global project setting (not a setup setting). The default state is unchecked.

The Motion window checkbox features (No Animation, Tool Spindle Always On, Check
Spindle Direction, Check Cutting Limits, and FastMill) are enhanced to provide a brief
description of what the feature does when the cursor is held over the feature.

The behaviour of Calculate Min Cutter Extension, in the Motion window, has changed.
When toggled on, the holder moves down to the bottom of the cutter. The first and
subsequent holders are processed independently, so one sees both the first and second
holder move down to the same location and the cutter will not be seen. As cutting starts,
the holders move up as needed to avoid a collision with stock.

The Calculate Min. Cutter Extension feature, in the Motion window, is enhanced to
automatically apply the calculated extension amount to the existing Gage Point Z value



and to consider all fixtures in a Workpiece view for both standard VERICUT and
FastMill mode.

VERICUT is enhanced to output a message to the logger when processing is stopped by
VERICUT explaining why processing stopped. Examples: file end, end of setup, tool
change, text, program stop/opstop, error/warning, etc.

VERICUT now supports pocket cycles in the XY, YZ, and ZX motion planes.
VERICUT is enhanced to support new tool type "tap".
VERICUT is enhanced to support "water jet" cutting.

A Save As choice is added to the right mouse menu displayed with the IP branch of the
Project Tree.

A warning message is now sent to the status bar and log whenever an embedded matrix
changes during processing.

Double clicking on a Control or Machine branch in the Project Tree now opens the Open
Control, or Open Machine window.

VERICUT is enhanced to enable visually differentiating tapped holes from other
drilled/bored/reamed holes.

VERICUT now outputs the error message, "Cannot find valid cutter data. Tool {%s
tool_id} is ignored.”, when a milling cutter is not defined correctly. For example, when
the tool has a linear offset along X or Y, or is rotated, and does not display in workpiece
view.

A new View > Dynamic Controls > Reverse mouse wheel feature enables reversing the
sense of "zoom" associated with rotating the mouse wheel.

Mate/Align feature is enhanced to display a plane selection marker after the first mouse
click of a mate/align operation. Plane marker remains visible during dynamic view
manipulation and in OpenGL until the next Mate/Align constraint is selected.

VERICUT is enhanced to support G32 face threading cycles.

VERICUT performance is significantly improved for the simulation, and Refine Display,
of grinder operations.

Milling on turning stock is now considered to be a valid cutting operation for any
tool/stock orientation (on-center or off-center). Material is removed by the tool which is
revolved around the stock turning axis. Full VERICUT support for such motions is
implemented (X-Caliper, .vcs files, Model Export etc.).

VERICUT is enhanced to support arrays containing alpha characters ($P_UIFR[1,X,TR])

A new feature, Calculate Relative to Location, in the Add/Modify G-Code Table window
enables applying an additional offset to a "relational offset" based on the machine's rotary
position where the offset will be used.

All turning tool images output by VERICUT are now drawn in a ZX orientation.



The color of the last section plane in the View Section window, Section Planes table, at
the time that the project file is saved, is now stored in the preferences file and becomes
the default section plane color for future VERICUT sessions.

An "undocked" Project Tree no longer disappears behind the VERICUT main window
when picking items in the VERICUT main window.

VERICUT is enhanced to correctly handle NX's updated format for turning TLDATA
statements of the form:
TLDATA/TURN,LEFT,OUTSIDE,0.0620,1.2500,5.0000,5.0000,6.0000,270.0000

A new LIMIT status light is added to the VERICUT main window to indicate the status
of travel limit checking.

VERICUT is enhanced to handle situations where a threading tool insert crosses the
spindle axis during an ID threading motion.

VERICUT is enhanced to enable creating a coordinate system at the center of a faceted
diameter by select the XY Plane and a point on the faceted diameter.

A new feature, Mirror Relative To, on the Modeling window, Position tab, Mirror tab,
enables selecting a previously define coordinate system from a pull-down list to mirror
about.

A new feature, OK To Cut Into Fixture, on the Modeling window, Component Attributes
tab, enables specifying fixtures that can be cut into during milling, tapping, and turning
operations. When OK To Cut Into Fixture is active, cutter/fixture collisions are only
output when they exceed a specified depth.

The View Axes window and the Display Axes list in the VERICUT main window, right
mouse button shortcut menu are enhanced to display multiple Driven Point Zero axes for
multi-channel sync jobs.

Select From/To Locations: Offset fields and the Enter Offset: Values field in the
Add/Modify G-Code Table window are enhanced to support calculations.

X-Caliper
X-Caliper is enhanced to enable measuring the depth of blind holes, countersunk holes,
the top and bottom radius of a cone, etc.

X-Caliper is enhanced to enable selecting the tool so that Air Distance and
Distance/Angle can be used to measure the distance between the tool and the stock.

X-Caliper is enhanced to enable picking a hole on a model file and getting the center
point.

X-Caliper is enhanced to provide feedback on tapped threads (e.g. pitch threads/inch (or
mm), etc.), like it does for turned threads.

When using a .vct based cut stock, cylinders and other non-planar features are now
recognized by X-Caliper, without requiring that an NC program to be specified. Clicking



on "Single Step™ or "Play to End" is all that is required. The planes of the .vct model will
continue to be reported by X-Caliper as Stock Model.

X-Caliper Feature/History for threads is enhanced to report threads per unit (TPU) in
addition to Pitch.

Miscellaneous Enhancements
Support is added for CAD Model Interfaces on Windows XP64.

VERICUT Reports is enhanced to enable the output of Minimum and Maximum Feedrate
and Minimum and Maximum Spindle Speeds for each tool.

Axial Depth and Radial Width from the OptiPath record are added to the features that can
be added to a report template for inclusion in VERICUT Reports.

A new VERICUT comment record, VERICUT-VARTAG record, is added to enable
assigning the value of an NC variable to a User-Defined Tag, from within the NC
program file, for use in a VERICUT report.

VERICUT is enhanced to enable using a VERICUT command record to save In-Process,
or VERICUT Solid files with a specified name.

PPRINT/VERICUT-COMMAND,SAVE_IP filename
(the file goes in the working directory, ".ip™ is appended if no extension is
specified)

PPRINT/VERICUT-COMMAND,SAVE_VCT filename
(the file goes in the working directory, ".vct" is appended if no extension is
specified, features are saved, saves the first cut-stock)

PPRINT/VERICUT-COMMAND,SAVE_VCT filename,FEATURES,YES
(the file goes in the working directory, ".vct™ is appended if no extension is
specified, features are saved, saves the first cut-stock)

PPRINT/VERICUT-COMMAND,SAVE_VCT filename,FEATURES,NO
(features not saved, saves the first cut stock)

PPRINT/VERICUT-COMMAND,SAVE_VCT filename,stockname
(features are saved, saves the specified cut-stock)

PPRINT/VERICUT-COMMAND,SAVE_VCT filename,FEATURES,YES,stockname
(features are saved, saves the specified cut-stock)

PPRINT/VERICUT-COMMAND,SAVE_VCT filename,FEATURES,NO,stockname
(features not saved, saves the specified cut stock)



VERICUT is enhanced to enable using VERICUT command records to Fit, Fit all and
Zoom out from within the NC program.

PPRINT/VERICUT-COMMAND,FIT
PPRINT/VERICUT-COMMAND,FIT_ALL
PPRINT/VERICUT-COMMAND,ZOOM_OUT

VERICUT no longer blocks access to control file features in the Configuration menu
when only the machine file is an Xfile (.xmch). Conversely, access to machine file
features no longer blocked when only the control file is an Xfile (.xctl).

Library Heidenhain TNC530 control is enhanced to support PLANE RESET TURN.
Library Heidenhain MillPlus control is enhanced to support Point Definition.

Library Fanuc controls are enhanced to support DPRINT/PLOS/POPEN commands.
Library Fanuc controls are enhanced to support Polar Coordinate G15/G16 commands.

The export, and import, of model formats using the Spatial R17 CAD Model Interface is
now supported on 32 bit and 64 bit computers.

VERICUT Reports is enhanced to enable choosing to display file names in the report
with the Full Path, or just with the File Name.

VERICUT Reports is enhanced to enable using user-defined tags, defined using a
VERICUT-VARTAG record or a VERICUT-USERTAG record, to be used within a
"Toolpath Loop", or a "Tool Change Loop" in a VERICUT report.

Batch Wizard is completely re-designed for V6.2.

The Tool Change List window is enhanced so that selecting a tool change event in the
Tool Change List window, causes the corresponding record in the Info > NC Program
window to become highlighted.

On the Add/Modify G-Code Table window, From and To Features, CSYS and
Component, are renamed to CSYS Origin and Component Origin to clarify that we are
using points.

Tile Vertically and Tile Horizontally icons are added to the Info > NC Program window
to enable specifying how multi-channel NC programs are displayed.

OpenGL texture files are now defaulted to "unchecked" in the File Summary > Copy
Files window.

The 'OperatorinputSelection' word is added to the VVcRes.Local file.

Cutter Limit messages in the logger are now preceded by the word "Warning" the same
as all other warning messages.

A graphic displayed by X-Caliper no longer remains displayed when the view is rotated.

The Offset values for Mate/Align in Assemble tab are now shown with 4 place accuracy
after the decimal like other values in the Modeling window.



VERICUT's file selection boxes are enhanced to display Windows Shortcuts.Ink objects
which point at a folder, enabling the user to double click to go to that folder for file
selection.

A right mouse button shortcut menu with the following options; cut, copy, paste and
restore, is added to the NC Program window.

VERICUT Tool List is enhanced to enable loading tools that have only a holder defined,
but no cutter.

A warning message is now output advising against, but not preventing, saving project
files with other than a .\VVcProject extension.

The DevKit tab, on the Advanced Control Options window is renamed to CME/API tab.

The icon toolbar in the Info > NC Program window is enhanced to adjust and wrap
around to an additional row, based on the width of the window, like the icon toolbar in
the VERICUT main window does.

A target icon is now displayed at the origin of the "active"” coordinate system.

The File Summary window is enhanced to show the file creation date and time for each
of the files.

VERICUT Customizer is enhanced to include a button option to display the Project Tree.

A new Text > Process Data feature, Stock Envelope is added to the Report Template
window to enable outputting the rough dimensions of the stock into a VERICUT report
document.

The Graphs: Depth feature is enhanced to provide more accurate depth of cut
information.

Problems Resolved in V6.2

AUTO-DIFF

Point vectors no longer change direction when you change the "active” coordinate
system.

A round off error causing Constant Gouge/Excess Check to fail to output an error
message under a specific condition is fixed.

CATV

CATV5 now recognizes and correctly processes CATIA Cutting Type parameter
SPINDLE.

CATVS5 can now correctly handle cutters defined with off-axis profiles.



CATParts are now automatically switched to "shaded" view if necessary before
generating STL, or VRML files.

CATVS5 now ignores the presence of Delmia elements when processing.

The Input Program Zero (Special Z) is classified as "obsolete™ and is removed from the
Table Name pull-down list on the CATV5 Options window.

G-CODE PROCESSING

An * (wild card) is now recognized as a valid SubSystem ID in the MDI window so axes
can be jogged using the Jog feature.

Support is added for the TOSNUC888 control's dual functionality for [ ] which can be
used as a mathematical precedence, or to denote an expression/variable assignment.

A problem causing the Driven Point, and Driven Point Axis to display incorrectly after
shifting the A component of a specific 5-axis configuration with A axis on C axis, is
fixed.

The EndLoop macro is enhanced to support the multiple level WHILE feature in Siemens
840D controls.

A new attribute type, 11, is added to the GageOffsetAttributes macro to produce an error
if the Driven Point ID does not match the active tool number.

Support is added to enable using an expression as a variable passed to a subroutine in a
Siemens 840D Control.

Composite fields, such as a composite T code, are now recognized as valid conditional
words.

Invalid "Tool axis not perpendicular to local motion plane” errors are no longer output for
a specific tool when used in an angled head.

A problem causing a Siemens 840D CYCLE97 with AxisMappingXtoU to not end at
SiemensCycle97Xend is fixed.

CGTechVarDefMacro now supports "string" arrays.

INSTALLATION

The Windows 64 create_license.bat now creates the cgtech.If license file in the correct
directory.

A problem causing the LicenseTool.exe to erroneously output a "cgtech.If created
successfully” when the cgtech.If file was empty because of an invalid license key format
where new line characters are lost. The following message is now output for the above
situation: "Invalid license format. Each license key must be in a separate line. License file
not created."”



MACHINE SIMULATION

The GotoJumpForwardBackwardStart macro no longer starts searching at the current
line. It now starts searching for the sequence number starting after the current line. If set
to search backwards, it starts searching at the previous line.

Transparent Stock has been removed from the Machine Settings window and the G-Code
Settings window: Settings tab. During cutting, the cut stock in Machine views are now
always displayed in a new faster mode and returns to a normal (better) display when
cutting stops. The new faster mode is the same as used during dynamic view rotation.

A problem causing a turret tool assembly, in a Workpiece view, to be incorrectly
oriented, or rotated, is fixed.

A problem causing the VERICUT session to hang when positioning a specific STL tool
holder down inside a TSOR stock is fixed.

A problem causing "Touch™ to not stop when a Stock model is made visible is fixed.

VERICUT is enhanced to enable stopping a large rotary move without killing the
process. Upon selecting Stop, a window displays giving you the option of continuing the
motion, or to cancel the motion and jump to the final position then stop.

A problem causing Gage Offset to be cancelled when selecting Play to End, or Single
Step, is fixed. This situation only occurred on the initial loading of the project file when
Initial Tool was set in the NC Program window.

A problem causing a false collision error to be reported, between holder (angle head) and
fixture due to inconsistencies of the STL file representing the holder, is fixed.

A problem causing false spindle direction errors for a threading insert, defined as a sweep
profile, is fixed.

A problem causing some fixture and stock models, to not display in a Machine/Cut Stock
view, for a specific project file when the project file is opened a second time is fixed.

A problem causing the Workpiece view and the Machine view to simulate differently for
a specific project file is fixed.

G72 Rough Facing Cycles now simulate correctly.

ConnectToCompName macro, in the case of LINEAR components, now supports the
Connect component being a motion component.

The following tool change macros are updated to support a new text argument REPORT.

ToolChange
ToolChangeByToolNum
ToolChangelfDifferent
ToolChangeSave
ToolChangeNoRetract
HcodeTool

ToolCode

StopProgram



StopOptional
LoadNextTool

The TurnOnOffGageOffset macro now produces consistent results regardless of whether
it is used with motion, or machine motion.

The SetDynamicVars macro now works correctly when configured to use the axis skip
feature (-1 indicating an unused axis).

A problem causing no material removal, when using CycleTurnThread to cut a tapered
thread, is fixed.

The SetMatchingGageOffset macro is adjusted to enable pre-V6.0 User files that use this
macro, to work correctly when used in post V6.0 VERICUT versions.

A CurToolAlpha option is added to the SetDynamicVars macro to support Tool IDs that
are a string instead of a number.

The Probe macro, used with Override Text value: RETURN=3$A PROBE[1] in a specific
project file, now correctly records a hit when using Rotary Motion with a probing routine.

The L word is now supported as a loop counter for G66 (CallNCMacroMotion macro) for
Fanuc 18M and similar controls.

MASTERCAM-TO-VERICUT Interface

The Mastercam-to-VERICUT Interface now supports operation names that contain "/"
characters.

Unexpected MasterCam X2 termination no longer occurs when the Mastercam-to-
VERICUT Interface encounters a tool name that is greater than 75 characters.

The Mastercam-to-VERICUT Interface C-hook now opens correctly when only the 64-bit
version VERICUT is installed.

OPTIPATH

A problem causing OptiPath Learn From NC Program to destroy the contents of the tool
library file, when Reset is used before pressing Play to End, is fixed.

OptiPath now outputs an error message when it encounters a multitool, which is not
supported.

OptiPath no longer creates an empty tool file, when Learn from NC Program is activated
with option Append to Existing Tool Library toggled on, and learn mode processing is
cancelled before it finishes.

OptiPath now outputs the correct APT SPINDL command after encountering a STOP
statement.



Tool Libraries containing OptiPath records now convert correctly from millimeter to
inch.

A problem causing OptiPath to output invalid Volume Removal Rate errors is corrected.

Optimization no longer fails, when using the Chip Thickness method for referenced
cutters with an undersized shank.

The Add Sequence Number to Added Blocks feature on the OptiPath Control window, G-
Code Output Options tab, OptiPath and Curve Fit tab, no longer adds one sequence
number when set to No.

OptiPath no longer outputs Air Cut feedrates while removing material, when optimizing
circular cuts that end in air while in FastMill mode.

A problem causing OptiPath to incorrectly output "Invalid Circle Statement" errors is
fixed.

The OptiPath Control window will now open without an OptiPath license but the window
will only contain the Material, and Machine, selection boxes.

Unexpected OptiPath termination no longer occurs when the original .mcd file cannot be
found.

OptiPath no longer produces a corrupt optimized file, for a specific project file, when
Accel/Decel is set to Continuous.

The OptiPath calculation of cutting depth is modified to provide more accurate values for
situations where the highest contact point on the cutter is close to the end of the tool
corner radius arc.

OptiPath no longer outputs an Air Cut feed rate on circular moves that begin in air and
appears to move tangent to the wall to be machined, but actually remove a tiny amount of
material.

TOOL MANAGER

Gage Offset selection mode no longer remains active after setting a Gage Offset value in
Tool Manager.

Tool Manager no longer produces a bad display of referenced OptiPath records.
Tool Holders now display correctly for referenced tool assemblies.

Referenced tools are now sorted correctly using the 1D header.

Mate and Align now work correctly for all Dynamic Control settings.

A problem preventing a milling tool, with inserts defined using a VERICUT linear sweep
file (.swp), from spinning and removing material is fixed.

Tool Manager no longer switches the X and Z coordinates for the insert created when
using a profile to define a milling tool insert.



Milling Tool Wizard now creates the first tool in a new tool library based on the "units"
setting of the project file.

DXF Import now calculates the correct gage offset for situations using "Control at tip"
where the lowest point on the profile is lower than DXF point entities that define the
profile.

Tool Manager fields Gage Point column, Orientation column, Driven Point (via
Description column), and Cutter Compensation (via Description column) are updated to
enable using calculations for value input.

The tool assembly method used for inserted tools no longer has an affect on material
removal when the tool is used.

NX-To-VERICUT Interface

NXV bat files for accessing NXV with NX versions 3 and 4, are now appropriately
named.

When "Use Tools from the Setup Template" is toggled on, VERICUT no longer merges
the tool library specified in the Setup Template with the NXV generated tool library file.

Automatically Output NC Program now only generates selected operations unless no
operations are selected, in which case, all operations in the NC program will be
generated.

Retain Setups in Project Template now correctly appends the operations in NX part files,
for situations where the Program Groups in the in the NX part files all have the same
name.

NXV now outputs tool files in XML format.

VERICUT now starts from NXV when a user defined tool is present but the tool is not
defined correctly for use in VERICUT. The problem tool is now ignored by VERICUT.

The Gage Offset for T-cutters is now correctly passed through NXV to VERICUT.

NXV now correctly creates tool lists for multiple setup jobs where each setup uses a tool
with the same Tool ID, but the actual tool is different for each setup.

VERIFICATION

A problem causing the first tool of the second NC program to not machine at the correct
Z level (i.e. tool cuts air), for certain situations where multiple NC program files are in
the list and "Initial Tool" is called at the start of the second program, is fixed.

The Animation Slider setting no longer remains in effect for metric project files when No
Animation is active.

A problem causing incorrect material removal in FastMill when using certain concave
bottom cutters is resolved.



A problem causing circular motion direction to be reversed in certain turning situations is
fixed.

When saving an IP file using CL data, the IP file now starts at the point where it was
saved.

The automatic appending of the tool path number and line number of the record causing
the event to the end of the base file name to create unique file names, now works
correctly for AutoSave options "In Process” and "VERICUT Solid".

Invalid collision errors are no longer output for a specific 5 axis motion with G1 active.

When setups are imported from a project file outside of the current folder/directory, all
referenced files include the path to their "parent” folder/directory.

Material removal is now correct for situations where Cutter Compensation mode is active
and the motion goes straight back to the previous position.

A problem causing incorrect material removal, when using a specific inserted groove tool
with a small radius, is fixed.

Erratic machine motion no longer occurs for a specific condition where only a very short
motion occurs between the times when Cutter Compensation is turned on and when
Cutter Compensation is turned off.

5-axis tool motion is now correct for a specific condition involving an inserted cutter,
defined to spin around the spindle axis, and a very short rotary motion.

Unit conversion of the current project file now works correctly for millimeter mode.

Command line options Append_log and LGFILNAM now work correctly when used
from the command line or when used for batch processing.

"Edit > NC Program" and "Info > NC Program" windows now respond correctly to text
size changes, and retains foreground/background colors.

A warning message, "Opening a .VcTmp file as a project is unlikely to provide
satisfactory results. Open anyway?", is now output when you try to open a .vVcTmp file as
a project file, which is a very bad idea.

VERICUT now outputs a message when libraries cannot be found.

When using Insert from MDI in the Info > NC Program window, VERICUT now
prevents pasting from the clipboard to the NC program when there is nothing in MDI
window NC Block List.

View Attributes, Translucency, and Clipping Plane positions, are now saved when the
view is stored using View Select/Store.

STL, .ply and .swp files used for the Stock and Fixtures are now displayed in the Info >
File Summary listing when encrypted machine files (.xmch) are used.

The tool now starts in the center of the pocket when using CYCLE 4 for milling pockets.

Coordinate Systems can now be constructed using the Circle method in a Machine/Cut
Stock view after moving the Cut Stock model to a different Stock component.



The Animation Speed slider position is now updates correctly when switching between
setups.

Helical motion around complete 360 degree arcs are now simulated correctly.
G76 INTERNAL Taper Threading is now simulated correctly.

The Pick Circle feature in the MDI window is modified to improve the ability to pick
holes.

Improvements are made to reduce the time it takes to open a project file that uses a Tool
Library file having tools referenced from many different tool libraries.

Using AutoSave to save In Process files at Tool Change now saves the Work Offset
values correctly in the IP file.

Simulation speed no longer gets extremely slow for situations where large numbers of
errors are written to the logger.

The Pick Vertex feature in the MDI window now works correctly when a tool is loaded in
the spindle.

The cut stock no longer disappears from a Profile view during Zoom In/Out actions in a
specific project file.

"Arc on" (tangential approach) and "arc off" (tangential exit) is implemented to support
Heidenhain conversational CYCL 214 circular pocket cycles.

Circular motion direction no longer becomes reversed for a specific project file.

A problem causing material removal to display correctly in a Workpiece view and
incorrectly in a Profile view in a specific project file is fixed.

The MDI window no longer creates a cut stock unless the Cut Stock feature is toggled
"On".

False Constant Gouge Check errors no longer occur when a certain Maximum Allowable
Gouge value is used, or when using an APT cutter description, or a profile tool is used.

The cut stock in a specific project file no longer becomes unclamped and breaks apart
when Delete Detached Stock is used with the Delete While Simulating feature toggled
"On".

FastMill mode and Replace Material When Stepping Back are mutually exclusive.
VERICUT now outputs a message informing you of that if you try to toggle both options
"On" at the same time.

Optimized time is now correctly calculated, and reported in the Status window, when the
Tool Override feature is used.

Material removal is now correct, for a specific concave bottom cutter, when used in Fast
Mill mode.

A problem causing gouges when using a specific inserted cutter is fixed.

Milling tool inserts, used in a specific project file, are now displayed in the correct
position in the Machine view when the Driven Point has a value other than '0 0 0'.



False holder collisions are no longer reported in a specific project file having a long
horizontal motion on a shape that has many indentations.

Making a small move on a very large radius, where the start point and end point of the
motion are nearly identical, no longer causes a full circle motion.

A problem causing very slow processing for certain blocks of a specific project file is
fixed.

The VERICUT session no longer "hangs" when a specific VERICUT Solid (.vct) stock
model is used on a 64 bit machine.

The Workpiece view is now updated correctly after a simple head rotation in a specific
project file.

Changes to the Jog Distance in the MDI window are now applied when jog +/- buttons
are used.

Calculate Min. Cutter Extension now recognizes holder/fixture collisions, and extends the
cutter to adequately clear the fixture obstacle.

Binary machine models used in encrypted machine files (.xmch) now display correctly in
VERICUT.

Phantom surfaces/material are no longer created and displayed during processing of a
specific turning project file.

False cutter/fixture collisions are no longer output for a specific project file when the
Animation Slider is set to maximum and Cutter Compensation is turned on.

The VERICUT session no longer locks up when using a specific turning insert with a
complicated sweep profile.

Material removal is now correct for the first pass of a peck drilling operation in a specific
project file.

Unexpected VERICUT termination no longer occurs when an NC Subroutine with a very
long directory/folder path is used.

When opening an In Process file using an APT NC program, the simulation/toolpath no
longer gets reset to the beginning.

Turning FastMill on for a specific EDM project file no longer causes the cut path to
become disjointed after rotating or selecting to Delete Detached Stock.

A problem causing a VERICUT Solid stock model, created in V5.4 and used in a V5.4
user file, to take on the shape of the revolved insert profile when the user file is used in a
post V6.0 VERICUT session is fixed.

The original Workpiece view no longer changes to an unrefined state, after using Zoom
to Box then closing the created view.

Having the Section window, and the View Orient window, open at the same time no
longer cause conflicts with mouse selection. A warning is displayed and Orient on
Feature is disabled when the Section window and the View Orient window are both open.



Rotating the view, after processing a specific project file that has Update While
Simulating in the Delete Detached Stock window toggled "On", no longer causes the
stock to disappear.

False holder collisions are no longer reported for a specific project file, using revolved
profile holders created in NX that contain an inner profile.

When Stop At, in the Motion window, is set to End of each Setup and AutoSave is set to
save an In Process file at End of each Setup, rotating a view during the save no longer
causes VERICUT to keep processing after the save, instead of pausing at the end of the
setup.

MISCELLANEOUS

A graphic displayed by X-Caliper, for example stock thickness indicator, no longer
remains displayed when the view is rotated.

Library Fanuc controls are now correctly configured for G7.1 cylindrical interpolation.
Library Fanuc controls calculate time correctly for G76 and G86.

Unexpected VERICUT termination no longer occurs when starting Mold and Die, or
Cutter Grinder, on UNIX.

Library 840D control now process the word =CTRANS correctly.
Library yasi80m.ctl and yasi80m.sub are updated to support work offset sub-registers.

The M128 command in the Library Heidenhain TNC530 control is moved into "states"
supergroup.

Using MDI without a Machine Simulation license now longer outputs a missing license
error message, but behaves the same way that it did in V6.0.

When a machine, control, or tool library file is changed and saved in one setup in a multi-
setup project file, then the same control is also used in a subsequent setup, the following
notice will be displayed: "<Machine><Control><Tool Library> is also used by another
setup in the project. Reload the project to access the new file."”

Support is added for RPCP in non-contour mode.

Spindle direction is now checked for each individual insert of a turning tool used for
turning, or thread cutting.

The information shown in the VERICUT log file, and in VERICUT reports is corrected
and enhanced for SYNC jobs.

Re-scans are now executed during Reset, if the Block Skip switches are changed.

Probe collisions are no longer missed on the first motion after the probe motion, when the
probe is moving away in slow motion mode.



The Apply Acceleration to Cycle Time check box on the G-Code Settings window, now
includes component Max Feed Velocity in its calculations, in order to produce more
accurate cycle times.

The Cut Stock is now displayed correctly for certain 5-axis cuts in a specific project file.

OptiPath Learn From NC Program no longer destroys the contents of the tool library file
used in a specific project file, when Reset is used before pressing Play to End.

Records created, or changed, using the comment record command (VERICUT-
OPTIPATH DESC ...) are now correctly reported in the VERICUT Log file and in
VERICUT Reports.

The "stick-out™” is now calculated correctly for tool assemblies using referenced holders.

The Project and Component Trees now update correctly after moving a project
component (Fixture/Stock/Design) then Cancel the window (instead of Apply or OK).

When the NC program file is listed multiple times in the NC Programs list, VERICUT
Reports now outputs data in a toolpath loop each time that the NC program is run.

Rotating a model using X+, Y-, etc. many times quickly no longer results in the stock
display disappearing or becoming distorted.

"Arc on" (tangential approach) and "arc off" (tangential exit) is implemented to support
Heidenhain conversational CYCL 214 circular pocket cycles.

An error is now reported if the clamp component specified in ClampCompName() macro
does not exist.

Pieces of detached material no longer remain displayed after using Delete Detached
Stock in a specific project file.

Fixture models now load correctly after importing a setup.

Errors detected by VERICUT are now displayed in both the graphics area (red mark) and
reported in the logger for situations where the tool plunges into material in rapid mode,
while in FASTMILL mode.

The "End" of processing image created is now displayed in the VERICUT report for
situations where there is an "inactive” NC program before the one processed by
VERICUT.

You are now able to select a screen recording region, via mouse selection/dragging, in an
OpenGL Machine view.

Selecting Cut Line, in the right mouse button menu in a Machine view, while in NC
Program Review mode no longer results in an "Action not allowed In NC Program
Review" error message.

Water jet cutting errors "Water Jet nozzle too close ..." and " Water Jet removing
material beyond maximum distance ..." are no longer missed in a specific project file.

False "Water Jet collided with another part of the model ..." errors are no longer output
for a specific project file.



The "Step Backward" and "Play Backward" simulation control buttons are no longer
missing from the NC Program Review window when accessed from a custom interface.

Prompts are added to guide users through X-Caliper multi-pick operations (Edge,
Mate/Align, etc.).

NC Program Review no longer shows the tool positioned in the wrong setup in situations
where multiple setups use the same NC program running in different locations.

Batch Wizard now correctly expands the /path/filename when files are selected using the
"Shortcuts" feature in the file selection window.

Unexpected VERICUT termination no longer occurs when you attempt to create a new
project and CGTECH_LIBRARY does not point to a folder containing an
"init.\VVcProject™ (or "initm.\VVcProject") file.

Error messages are now displayed in the message area (logger) when an In Process file is
opened.

False holder/stock collision errors are no longer reported when running a specific V5.4
user file in V6.1.2.

A problem that sometimes prevented the saving of a modified NC program when the
Acrobat Reader was opened with VERICUT Help is fixed.

VERICUT reports now correctly show cutting tools and run times, for situations where
the first NC Program in the list is "inactive".

Selecting the error in the NC Program Review message area no longer reverses the tool
display in the Workpiece view for a specific project file.

Using a 180 degree arc in a sweep profile used to define a stock now produces a model
that is consistent in both the Model Sketcher and in the VERICUT simulation.

The Library Heidenhain TNC530 control is enhanced to support Internal Threading
Cycle Def 262 via subroutine. The subroutine was added to existing hei530.sub.

Block Skip switches now work correctly in Customizer.

NC Program Review has been improved to work better with subroutines called from the
main program.

The Motion window is now re-sizable.

The processing of probing tools that have one, or more, probe tips off of the Z-axis of the
tool is modified to improve the display, and the detection of collisions.

The Create Report feature now behaves consistently whether it is accessed from
VERICUT File menu, from Tool Manager, or from the Inspection window.

Profile views used in recording VERICUT Image files now display correctly during
playback.

The tool library no longer changes after using Calculate Min. Cutter Extension, then the
saving of the tool library is rejected for a specific, multiple setup project file.



Unexpected Cutter Grinder and Mold and Die termination no longer occurs due to a
missing start-up project file.

The two probing post processor files (.\VVcPost) included in the "samples” directory are
updated to include a subroutine to enable defining the format for comment statements.

Memory is now correctly released upon reset for a specific probing project file that
contains sound clips.

MDI with "Cut Stock™ active now correctly removes material, and reports holder
collisions, when a specific NC block is used in a specific project file.

New Macros in V6.2

The following new macros are added for V6.2. See the VERICUT Macros section, in the
CGTech Help Library for more information.

AbsoluteShiftRotationDynamic
ActiveSpindleActiveStock
AddModelRemoveAllModels
AddModelSetColor
AddModelSetFileName
AddModelSetNormals
AddModelSetRelComponent
AddModelSetRelPosition
AddModelSetUnits
AddModelToComponent
AutosetTableAxisFrames
AutosetTableAxisVarsAdv
BlockBeginLabel
BlockEndLabel
CircleARParameter
CompToCompOffset
CycleAxis

DynamicTool TipOnOff
ElTapePolarAngle
ElTapeVirtualAxis
El_SpinningMode
FanucDprint

FanucPclose

FanucPopen

FeedTime

FeedTimeMin
HeidCycleMillThread
HeidDefinePoint
HeidGotoPointSeq



HeidPointIndex
HeidReturnFromSubCall
MultiPointCyclesExecute
NewCycleLogic

OriMode

Pogo

PogoCollisionCheck
PogoSetAbove Tolerance
PogoSetBelowTolerance
PogoSetCollisionTolerance
PogoSetMaxAngle
RepaintCutColor
ResetCutColor
RestoreChangeSubsystemID
RestoreSetSubsystemID
RestrictRotaryAxis
RotaryDirPosCCWADbsolute
RotaryDirPosCWADbsolute
RotaryDirShortestDist180CCW
RotaryDirShortestDist180CW
Rotary FeedRate
RpcpContour

RpcpOffset
RpcpWithMotion
SetCutColor

SetCycleDepth
SetCyclePartSurface
SetCycleRapidLevel
SetCycleRetractLevel
SetErrorStatusVar
SetMultiPointCount
SetPolarAngle
SetPolarinput
SetPolarRadius
Siemens840DSubSequenceStart
SiemensActiveZeroOffset
SiemensCmd201
SiemensSystemFramesCancel
SiemensTOFRAME
SiemensTOROTOF
SiemensWorkCoord
SiemensWorkCoordIndex
Siemens_P_PFRAME
SpiralMotionOnOff
SubroutineNameNumeric
SubroutineNameText



TableSubRegisterValue
TangentialAngle
TangentialCapture
Tangentiallnit
TangentialMethod
TangentialMovement
TangentialPolar
TangentialRadius
TangentialStartZ
TravelLimitGroup
VirtualZaxisDynamic
WaterJetOnOff
WorkingPlane
WorkingPlane2AbcVertAxisRule

New Conditionals in V6.2

The following new Conditionals are added for VV6.2. See Conditionals - listed
alphabetically, the VERICUT Help section, in the CGTech Help Library for more
information.

GeminiCondEqual
HeidCondLeftParen
HeidCondMultiply
HeidCondRightParen
TosnucCondVWord

New Functions in V6.2

The following new Functions are added for VV6.2. See Functions - listed alphabetically,
the VERICUT Help section, in the CGTech Help Library for more information.

AbsCeil

ISNUMBER
NUMBER
SiemensCFINE
SiemensCMIRROR
SiemensCROT
SiemensCSCALE
SiemensCTRANS
SiemensMEAFRAME



VERICUT 6.2.1 Interim Release

Release Notes

August 21, 2008

VERICUT Version 6.2.1 contains everything described above for V6.2, plus these
additional fixes/enhancements.

CATIA V5-t0-VERICUT Interface (CATV5)

CATV5 is enhanced to enable reading the current setup template and populating the
Options dialogue with the G-Code table choices contained within it. There is now a "?"
button next to the list of table names in the Options dialog. Clicking it causes a scan of
the current setup's template VVcProject file. All table names encountered will be placed in
the choice list. The FIRST table encountered with a "from" component will be the
selected one, along with its register number and from component.

CATV5 now processes TRACUT and TRACUT/NOMORE statements correctly whether
the CATIA option "Process TRACUT and COPY operations” is toggled On, or Off.

A problem causing new part operations, appended to an existing VVcProject file in
CATVS5, to replace the existing ones if it is named the same in the CATProcess is fixed.

G-Code Processing

Macro CycleTurnFinish now correctly outputs the final point of the turning cycle.

Support is added for Siemens 840D $P_BPRAME to enable cancelling only a specified
frame. $P_BFRAME is implemented with the initial values based on Base Work Offset
table. The additional frame values are supported using system matrices. Macro
SiemensSystemFramesRestore is added with text parameters BFRAME, IFRAME,
PFRAME and ALL to enable disabling a specific frame, or all frames. Macro
SiemensSystemFramesCancel is modified to use the same text parameter values. Both
macros can be used to support modal or non-modal cancel frame commands (G53, G153,
SUPA etc).

Support is added for Siemens CASE statement using the following syntax:
CASE expression OF 1 GOTOF LABEL1 2 GOTOF LABEL?2 ... DEFAULT GOTOF

New functions, STRLEN, TOUPPER, and SUBSTR are added to support Siemens 840D
control functions SUBSTR, STRLEN and TOUPPER.



Support is added for Siemens 840D commands SCALE and ASCALE used with
$P_BPRAME. Frame logic is enhanced to process the scale factor and new macros
RotationPlaneXScale, RotationPlaneY Scale, and RotationPlaneZScale are added to
enable specifying the axis that the scale factor is to be applied to.

Using bi-directional variables in the part program to populate offset tables once again
works correctly.

New macros RegisterMapping, RefreshToolOffset, and ToolOffsetRegisterName are
added to support the Siemens 840C G16 command. The functionality of these macros
may also be applicable to other controls.

Siemens 840D TOFRAME positions are now output correctly for angles greater than 90
degrees and less than 270 degrees. A new option, TOROT, is added to macro
SiemensTOFRAME. It is called by setting "Override Value” to 1. The option is used to
orient the primary and the secondary axes of the matrix ($P_PFRAME) created by
TOROT command. When option is not active the primary axis orientation is defined by
rotation of old matrix to a new position specified by the TOROT command. When the
option is active the secondary axis of matrix is aligned with the Z-X plane vector, where
Z is new matrix Z axis and X is old matrix primary axis. This option is equivalent to
840D option set by variable X_AXES _IN_OLD_X Z PLANE.

New macros RestrictRotaryAxis and WorkingPlane2AbcVertAxisRule are added to
support the Siemens 840D angle selection method (cycle800).

GibbsCam-to-VERICUT Interface (GibbsV)

When using the "Append to existing setups in Project Template" feature with a template
file that contains an existing setup, GibbsV now creates an operations (ops) file that will
create the correct number of setups when passed to VERICUT.

Machine Simulation

Material removal is now correct for a specific cutter insert profile used during a multi-
axis cut.

The material removal displayed in a Workpiece view is how consistent with the material
removal displayed in a Machine/Cut Stock view for a specific NC program.

A condition causing the feedrate of first sub-system, to override the feedrate of the
second sub-system, when using sync'd sub-systems is corrected.

Unexpected VERICUT termination no longer occurs when a comment using a Type Il
string that is longer then 256 characters. Macros Type2CommentAllArgs and
Type2CommentAllArgs are modified to use dynamically allocated strings rather then
fixed length buffers.



A problem causing false "Cycle feed is positive along Tool axis" errors to be output to
the Logger is fixed.

The distance moved is now correct when using the MDI Machine Motion Jog feature to
step along the tool axis of a Tricept tripod machine.

A specific groove tool now displays correctly in the Machine/Cut stock view.

OptiPath

Optimized feedrates no longer oscillate when optimizing motions that are not along one
of the cut stock axes.

Opening the OptiPath Control window no longer causes an OptiPath license to be
checked out.

The "PPRINT/VERICUT-OPTIPATH off" comment record now turns OptiPath
processing off.

Tool Manager

Unexpected VERICUT termination no longer occurs when Turret Setup is selected in
Tool Manager.

A specific DXF Profile imported from NX4 now cuts correctly after importing it into
VERICUT Tool Manager.

NX-to-VERICUT Interface (NXV)

A ugv_v20_user.prefs file that contains extremely long directory paths no longer causes
unexpected NX4 termination when NX4 is started from NXV.

Verification

Long delays are no longer experienced during the Reset of a specific project file.

A specific turning tool no longer displays in a rotated 180 degrees orientation in a
Workpiece view when the Animation Speed Slider is set to less than 100%.

False Holder to Cut Stock collisions are no longer reported during the tool retract move
for situations where a "Turn" type tool is used instead of a "Mill" type tool to allow Turn
Milling with Driven Points located off the tool axis.



A specific face mill defined using round cutter inserts now correctly removes material
when cutting, and no longer reports false holder collisions.

The coordinate system (CSYS) used for Cut Stock transition is now preserved when
using Merge IP.

Multiple Temporary Design components are no longer created when an IP file is merged.

A specific project file no longer has an extremely long delay before starting the
simulation on a 64 bit computer.

Clicking on the model to fill any of the X-Caliper, or Coordinate Systems window,
mouse-fed fields/features no longer results in a message from VERICUT indicating you
selected off material when working on RS6000/AIX.

Material removal is now correct when using a specific cutter insert profile with a corner
radius.

A driven point offset in Z no longer causes the flute length to change.
The View menu > Dynamic Controls menu option Unigraphics has been changed to NX.

After starting a "New" session and defining/importing the stock shape, and pressing Play
to create the Cut Stock model, setting a section plane distance value via mouse pick no
longer fails.

After starting a "New" session and defining/importing the stock shape, pressing Play to
create the Cut Stock model, and then sectioning, using "Keep" material from the
sectioned model no longer fails.

VRML is not supported on 64 bit computers (Windows or UNIX). The following
message is output if you try to load a VRML file in VERICUT on a 64 bit computer.
"VERICUT cannot open VRML files on 64 bit computers".

NC Program Review now displays the Start marker (green arrow) properly when the
V/cProject file has a forward slash /" in one of it paths.

Travel limit checking is enhanced such that when "Allow Motion Beyond Limit" is
toggled Off, and an axis limit is exceeded, an axis is only allowed to move when an axis
command, or compensation related to the axis is applied, caused motion.

Hole Depth measurement in X-Caliper now works correctly when AUTO-DIFF Constant
Gouge Check is active.

Using a specific tool holder profile with a radius no longer results in false collision with
stock errors being reported.

A problem causing a specific Mate/Align constraint relation to fail to locate the cut stock
model, and issue a "Constraint relation not allowed" error message, is fixed.

VERICUT now properly recognizes selections made in the Machine view during
Coordinate System (CSYS) construction.

Blind hole measurements obtained using X-Caliper on 32 bit computers are now correct.

In multi-setup simulations, X-Caliper now correctly measures a fixture in a Workpiece
view after the cut stock model has been moved.



The CAD Model Interface installer is updated to enable reading CATIA V5 R18
CATPart files as models.

Unexpected VERICUT termination no longer occurs after loading an IP file and pressing
Single Step.

X-Caliper hole depth calculations are now correct for situations where a hole depth is
measured, then only a new hole top feature is selected and Measure is pressed.

Unexpected VERICUT termination no longer occurs after using the "Machine Motion
Jog" feature in the MDI window with Showroom file dmg_dmu60t_heimplus.VVcProject.

A problem causing the cutting limits in a specific project file to not be recognized, until it
is run, Reset and run again, is fixed.

Milling tools using round cutter inserts now remove material correctly when cutting.

Material removal no longer takes place, and error message "Tool xxx cannot be used in a
milling operation as its driven point is off the tool axis™ is now output when a milling tool
that contains a driven-point that does not lie on the tool axis (i.e. has an X and/or Y
offset) is used. A special case allows the use of this type of milling tool to be used IF both
of the following conditions are met:

A) Spin Around > Machine Spindle is enabled in Tool Manager.
B) The holder is an STL file.

Miscellaneous

The Library Siemens 840D control is enhanced to support the CALL BLOCK Label 1
TO Label 2 command.

The Library Heidenhain TNC530 control no longer generates an error when entering a
subroutine.

The error message that is output when a license Host ID does not match any of the Host
IDs on the computer is enhanced to show the Host IDs found on the computer and more
clearly describes what the user needs to do to resolve the situation.

Sample project files, mill_tool_length_comp_g43_3ax_fanuc_in.VcProject and
mill_tool_length_comp_g43_3ax_fanuc_mm.VcProject have been changed to use
Programming Method "Tool Length Compensation™.

Setup Plan now displays dimension lines correctly for horizontal dimensions created in
the XZ and YZ views.

The TDM Interface is implemented for 64 bit machines.

Calculate Minimum Cutter Extension is enhanced to better handle complex holder
profiles that may have indentations inside both the concave bottom and the concave top.

Tool reports that have the Cutter Stick-out parameter defined, and tool holders that have
been rotated into position, now report the correct stick-out lengths.



A problem causing X-Caliper to return incorrect values for certain unusual tool profiles is
fixed.

The vericut_tools_french.VVcTemplate file is corrected so that it correctly creates a Tool
Manager Report.

Training machine file, maxcgt.mch is updated so that it works correctly.

New Macros in V6.2.1

The following new macros are added for VV6.2.1. See the VERICUT Macros section, in
the CGTech Help Library for more information.

DisableBaseWorkOffsets
DisableWorkOffsets
RefreshToolOffset
RegisterMapping
RotationPlaneXScale
RotationPlaneYScale
RotationPlaneZScale
SiemensBasicOriginFrame
SiemensSystemFramesRestore
ToolOffsetRegisterName



VERICUT 6.2.2 Interim Release

Release Notes

March 5, 2009

VERICUT Version 6.2.2 contains everything described above for V6.2.1, plus these
additional fixes/enhancements.

CATIA V5-t0-VERICUT Interface (CATV5)

The “Remove selected design part” icon now displays correctly.

A new group of features, “Model Chordal Deviation”, on the CATV5 Options window
enable you to specify a different tolerance value for Design, Stock, and Fixtures.

G-Code Processing

G72 Rough Turning Cycle now processes correctly when switching between the main
spindle and the sub-spindle.

The ability to use negative values for cutter compensation is fixed.

Support is added for Haas G13. A new override value is added to the
CycleMillPocketType macro. Use an override value of 3 to specify a circular pocket with
support for cutter compensation.

Fast feed errors are now consistent for macro FeedPerMinuteType Override Value =0
(feedrate as a real units-per-minute feedrate) and Override Value = 3 (special case for
Sinumerik 840D controls).

When a comma is included in a text string surrounded by quotation marks, (for example,
"Text with a comma, in between 2 text quotes™) the entire quoted string is used for the
parameter of a call to a PROC. The comma is no longer interpreted as the end of the first
parameter.

Using commas within a STRING definition and initialization (for example, DEF

STRING[100] _MMCK="CYCLES,LM,") no longer prevents a VV6.1.2 project file from
opening in a V6.2.2.

The WorkingPlane macro is enhanced to support offsets as the default behaviour.
G54 Relational Offsets are now processed correctly when using Virtual Y Axis.



A problem causing MillPlus G61/G62 Tangential Approach/Tangential Retract to
produce unexpected results under certain conditions is fixed.

The order of multiplying the matrices associated with the WorkingPlane and
RotationPlane macros is no longer reversed.

Two new macros, CycleTurnDiameter and CycleTurnTaper, are added to support the
Fanuc G90 taper cutting cycle.

New macro CycleTurnThreadOff is added to support using a G292 to turn off a thread
turn cycle.

Relational Offsets are now correct when used with a rotated X-axis.

Job subroutine processing is modified so that if the subroutine is defined by the filename
(for example, 8132.sub), and there is a statement that marks the beginning of the
subroutine (for example, 08132), then the subroutine begins at this point and not the first
line of the file.

A new type 0 is added to the Ijk2AbcType macro. The new 0 type is the default and
behaves like universal type 99. Type 99 is retained to support existing controls.

Tangential Approach now works correctly when used with cutter compensation.

A new macro SetGageOffsetVar is added to enable setting the specified variable (text
value) to the current z value of the gage offset (gage point - driven point).

The ToolRetract macro now works correctly regardless of how the Travel Limits
"lgnore" switch is set.

Two new Override Values have been added to the Ijk2AbcType macro.
28 = Specific, Tricept (A24 rotated 90).
29 = Specific, Tricept (A24 rotated 90) - no Travel Limit checks in determining best
angle.

The Siemens 840d control requires that string values be enclosed in double quotes (™).

VERICUT is enhanced to check if the string value is enclosed in double quotes. If it is
not, then the string variable is set to an empty string and the following error message is
displayed:

"Variable type string missing quotes on line:"

The VERICUT session no longer "hangs" when CircleIntemediatePoints is equal to zero
(co-linear points).

The WorkCoordY Value macro now mirrors correctly when doing a def 7 shift while in
mirror mode in TNC 530.

GibbsCam-to-VERICUT Interface (GibbsV)

GibbsV no longer incorrectly identifies output STL files as VERICUT polygon files.
The GibbsVFrench.local file is updated.



GibbsV is enhanced to support multiple VERICUT G-Code tables. A new group of
features "Machine Settings" on the GibbsV Options window enable you to specify:

Table Name — Select Work Offset, Base Work Offset, Program Zero, or None from
the pull-down list.

Register Number — Enter the register number.

'From" Component — Select the name of the component that represents the "from"
point for determining the offset from the pull-down list. VERICUT will use the origin
of the specified component.

'To" CSYS — Select the name of a CSY'S to represent the "to™ point for determining
the offset from the pull-down list. VERICUT will use the origin of the specified
CSYS

Machine Simulation

VERICUT collision messages are enhanced to output an Error message when the
involved models actually collide and a Warning message when the involved models are
within the Near Miss value but do not actually collide.

Mastercam-to-VERICUT Interface (MCAMV)

A new feature, "Put operations in a single VERICUT setup”, on the MCAMYV Options
window, enables you to put the selected MasterCAM operations into one VERICUT
setup. Toggle "on" (checked) to put operations into one VERICUT setup. Toggle "off" to
put each MasterCAM operation in a separate VERICUT setup.

"Browse" buttons are added to simplify the selection of Part STL Files and Fixture STL
Files on the MCAMYV main window.

MCAMYV is enhanced to support multiple VERICUT G-Code tables. A new group of
features "VERICUT GCode Table" on the NXV Options window enable you to specify:

Table Name — Select Work Offset, Base Work Offset, Program Zero, or None from
the pull-down list.

Register Number — Enter the register number.

'From" Component — Select the name of the component that represents the "from"
point for determining the offset from the pull-down list. VERICUT will use the origin
of the specified component.

'To" Csys — Select the name of a CSY'S to represent the "to" point for determining
the offset from the pull-down list. VERICUT will use the origin of the specified
CSYS.



Tool numbers created and passed through MCAMV to VERICUT now match the tool
numbers defined in MasterCAM X3. Due to differences between MasterCAM X3 and
MasterCAM X3 MUL1, the following environment variable must be set as described
below to ensure that tool numbers are created and passed correctly through MCAMYV to
VERICUT. Set the environment variable in the .bat file that you use to start MasterCAM
or set it using the Microsoft Control Panel > System > Advanced tab > Environment
Variable feature.
If you are using a MasterCAM part file created using the initial version of MasterCAM
X3, set the environment variable CGTECH_MCAMV_TLNO _IS_SLOT equal to 1as
shown below:

set CGTECH_MCAMV_TLNO IS _SLOT=1

If you are using a MasterCAM part file created using MasterCAM X3 MUL or later, do
not use this environment variable (or set it to 0).

NX-to-VERICUT Interface (NXV)

Turning tools are now oriented correctly when passed to VERICUT through NXV.

A "Browse" button is added to the Output Directory feature on the NXV main window to
simplify specifying the directory to receive NXV files. This feature is implemented for
Windows only. It is not possible to implement for UNIX.

NXV now exports tools from NX correctly for situations where "Operation Navigator -
Program Order" includes one or more sub-directories with the tool definitions.

NXV is enhanced to support multiple VERICUT G-Code tables. A new group of features
"VERICUT GCode Table" on the NXV Options window enable you to specify:

Table Name — Select Work Offset, Base Work Offset, Program Zero, or None from
the pull-down Table List or enter a name in the Table Name text field.

Register Number — Enter the register number.

'From' Component — Select the name of the component that represents the "from"
point for determining the offset. VERICUT will use the origin of the specified
component. Select from the pull-down 'From' List or enter the name in the 'From'
Component text field.

'To" Csys — Select the name of a CSY'S to represent the "to™ point for determining
the offset. VERICUT will use the origin of the specified CSYS. Select from the pull-
down "To' List or enter the name in the 'To' Csys text field.

Tool features are now correctly passed to VERICUT through NXV when using NX4.

NXV is enhanced to enable transferring NX turning data (turning tools, stock from a 2D
profile, design from a 2D profile, CLS NC program) to VERICUT.

A new checkbox "Transfer All Coordinate Systems” is added to the NXV Options
window enabling all NX coordinate systems associated with current NC program to be



passed to VERICUT. When toggled "off", only the coordinate systems required by
VERICUT (PROGRAM_ZERO and ***STOCK***) will be transferred.

Environment variable CGTECH_NXV_OUTPUTDIR is added to enable specifying a
default output file. Example of use:

set CGTECH_NXV_OUTPUTDIR=C:\Documents and Settings\Username.

NXV determines the default output directory according to the following rules:
1. If the environment variable is set, its value is used as the default output directory.
2. If the environment variable is not set, the value saved in the NX model is used.

3. Finally, if neither of the above is used, the directory containing the NX model is
used.

NXV is enhanced to enable passing multiple NX fixture models to VERICUT as
individual STL models.

A new feature "Attach Component List" is added to the NXV Options window to
simplify the specification of the Attach Component Name. Attach Component List
enables you to select the desired Attach Component from a pull-down list. The pull-down
list contains all of the Attach Components contained in the machine referenced by the
specified Setup Template.

NXV is enhanced to more accurately pass the following types of NX tool features into
VERICUT.

e When the NX Tool Insertion - (OS) Offset feature is used to specify how far the
Holder overlaps the Cutter.

e NX User Defined tools.

e Counter sinks created in NX under their "hole making" category.

NXV is enhanced to support the NX center drill definition.
NXV now correctly passes NX defined step drills into VERICUT.
NXV now correctly passes NX4 APT 7 parameter drilling tools to VERICUT.

Tool Manager

Tool assemblies are now created regardless of the order in which the tool components are
defined.

VERICUT is enhanced to transfer the flute length of a revolved cutter from TDM to
VERICUT.

Unexpected VERICUT termination no longer occurs when using a "referenced" tool with
Turret Setup on 32 bit computers.

The tools created by VERICUT using a specific DXF tool profile, and a specific tool
profile passed to VERICUT through the Pro/E-to-VERICUT Interface no longer contain
holes.



Closing the Tool Manager window after using Turret Manager no longer leaves a "ghost"
Tool Manager window displayed when using JRE 1.6.

The Flute Length witness line is now displayed correctly in the Tool Manager graphics
display area for cutters using an inverted cutter profile.

Verification

The VERICUT session no longer “hangs” when you Reset and then pressing Step/Play
with the Add/Modify Word/Address window open.

Unexpected VERICUT termination no longer occurs on 32 bit computers under very
specific conditions during workpiece cut-off on a MillTurn machine.

VERICUT is enhanced to provide more accurate material removal for certain profile
cutters that were created from imprecise profiles.

When using NC program commands in the MDI window to un-blank fixture models,
closing the MDI window no longer causes the fixture model to become blanked again.

The "Remove Block Numbers" button in NC Program > Utilities >Block Renumber now
works correctly.

The way that VERICUT processes Cutter Compensation is enhanced.

How VERICUT turns "on™ Cutter Compensation is now dependent on the block. The
three possible scenarios, and the options available for each, are described below:

1. Turning on with motion within the plane
a. Ramp ON
b. Immediate
2. Turning on with no motion
a. Ramp ON
b. Immediate
3. Turning on with the only motion being outside of the plane
a. Ramp ON with Active Plane Motion
b. Ramp ON with Any Motion
c. Immediate

The existing "CDC On/OFF Method" and "CDC Ramp ON/OFF with" values will be
used to set the default settings for the three turn "on" scenarios described above.

How VERICUT turns "off" Cutter Compensation is now significantly different.

1. All motions that were held will be processed.

2. When VERICUT finishes processing the block, it will longer be in Cutter
Compensation look ahead™ mode.



3. If no motion occurs on the block, then the current physical location of the tool
will be different than the last input coordinates that were specified. The following
options are available to specify how to process this case:

a. Adjust the input coordinates to the current physical position of the tool
(Default)

b. If the macro CutterCompOffHold is called with an Override Value of 1,
then this value will be set to "Do not adjust the input coordinates to the
current physical position of the tool”. This will cause a "Ramp OFF" type
move on the next motion.

NOTE: This macro becomes obsolete with this change. VERICUT will no
longer be staying in Cutter Compensation "look ahead" mode. This macro
is now only being used to set the ramp off flag.

A new macro, CutterCompOnOffSwitches, is added to enable setting the flags which
specify how to process the turning on, and turning off, of Cutter Compensation. This
macro can be used to set all of the flags described above.

VERICUT is enhanced to output a message to the logger, indicating why it stopped
processing, when it stops due to one of the Motion window "stop” settings.

Setting animation slide bar to slow motion no longer interferes with interactive "Stop”
action.

Spindle speed, in ConstantSurfaceSpeedMode, is now calculated correctly for all "driven
points".

The error message output when the minor diameter of a tap exceeds the drilled pilot hole
is enhanced to read "Tap minor diameter of ....".

The tool and holder, for a specific tool assembly, no longer separate during simulation
when Control Point is set to Corner Radius in the Motion window.

The normals for round insert cutters no longer become inverted when the spindle is
turned on.

The VERICUT session no longer "hangs™ during the processing of a specific NC
program for a 2 channel mill/turn machine.

Unexpected VERICUT termination no longer occurs, and material removal is correct,
when processing an ID turning thread cycle, for a specific project file on a 64 bit
compulter.

VERICUT is enhanced to detect "shank" errors when using Calculate Minimum Cutter
Extension. The "shank™ is defined as the portion of the cutter above the flute length, or
the first holder if a revolving insert cutter is used.

Using comment records in the NC program file to populate tables used in a VERICUT
report once again works correctly.

The CAD Model Converter no longer fails when the "dtol=" parameter is used from a
command line, or in a Batch Wizard script.

"Driven Point" values are now output correctly to a VERICUT report.



VERICUT is modified to make an on-center probe touch return the exact value in most
cases when probing the walls of a hole. VERICUT cannot guarantee the exact result in
100% of the cases due to approximate nature of the calculation. Accuracy depends on the
size of the hole to be probed, on the size of the probe tip, and on the Cut Tolerance.

VERICUT is enhanced to reduce processing time for situations where the tool profile
crosses the centerline of the cutter.

VERICUT no longer creates two "view capture" files, when AutoSave >View Capture is
set to "End of File", for a specific project file.

After face milling a part with a specific inserted tool, X-Caliper now returns a consistent
stock thickness regardless of whether the milled, or un-milled, face is picked.

Compensation offsets are once again correctly output to a VERICUT report.

A problem causing a bad cut surface display when a specific V5.4.5 APT source project
is played in V6.2 is fixed.

The collision errors reported by VERICUT are now consistent with those reported in
V5.4.6 when processing a specific project file, using a specific concave bottom cutter.

Cutter Compensation is now simulated correctly for a specific Pro/E ncl file.

VERICUT no longer produces a bad surface image when using a specific tool holder
definition created in VV5.4.

Holder collisions are now reported correctly when SOR defined tool holders are used in
an orientation other than "0 0 0".

The cutter now correctly moves to the center of the hole before retracting out of the hole
when executing a CYCLE90 command with the sin840d.ctl in the VERICUT library
directory.

Unexpected VERICUT termination no longer occurs when loading a specific project file.

When running a threading cycle on a mill/turn sub-spindle, a right handed thread is now
displayed correctly in VERICUT.

Miscellaneous

It is now possible to install the VERICUT license server only, on both Windows and
UNIX platforms, without JAVA.

Japanese text is now correctly translated for AVI files created in Image Record.
View Capture file size is now correctly translated to Japanese.

Machine and Control “Message Notes” now display correctly when they contain mixed
(English/Japanese) text.

AutoSave, View Capture files are now saved correctly when the file name contains
Japanese characters.



VERICUT now correctly reads STL files from a Japanese version of Pro-E.

Support is added for Fadal 88 control variables, AX, AY, AZ, AA, AB, and AC, used to
store current axis positions, to the library control file.

Support is added for Sinumerik 840D PROC call of the form L9935 in the VERICUT
library control.

The Fadal88a library control file is updated to include the FeedModeRevolution macro
for tapping.

The existing practice of using the ToolLengthCompValue macro to create a Tool Length
Comp table, and then using the AutosetToolLengthCompVars macro to set system
variables based on that table, has been replaced by the new SetGageOffsetVar macro in
all Fanuc library file controls.

The Heidenhain 530 library control file is updated to execute the CYCL DEF 5.0
CIRCULAR POCKET command at M99.

The Fanuc 15t and Fanuc15t_t library control files are updated to correctly process
circular interpolation.

The Okuma OSP library control files are corrected so that the V word format is defined
as a variable tag, instead of a variable name.

Macro Siemens840DSubroutineSequence is replaced by the new
Siemens840DSubSequenceStart macro in the 840d.ctl library control file.

All older sweep files in the VERICUT samples, library and showroom directories have
been updated to V6.2 to improve reliability.

Reports from Setup Plan are now successfully created in PDL format.

The showroom Makino MAG3 machine head model no longer "spins"” when the spindle
turns on.

The VERICUT library controls are updated so that the motion resulting from a G43.4
command matches that of the machine.

The VERICUT library controls are updated so that the motion resulting from a G43.1
command matches that of the machine.

The library control file, hei530.ctl is updated to enable LabelMacro and Heid_CallLbl to
processes correctly when HeidCondMultiply is used.

The decimal values added for tables in Machine Setting (or Job Settings) are now saved
correctly in the Project file when French Regional Settings are being used.

Unexpected VERICUT termination no longer occurs when loading
2_axis_lathe_template_inch.vcproject or 2_axis_lathe_template_metric.vcproject in the
VERICUT /library/ directory.

Rotary settings are no longer lost when creating an encrypted control file.

An NC program can now be successfully loaded into a new VERICUT project file using
the VNCK NC Program dialog.



New Macros in VV6.2.2

The following new macros are added for V6.2.2.

CutterCompOnOffSwitches
CycleTurnDiameter
CycleTurnTaper
CycleTurnThreadOff
ElVirtualSpinOffsetY
ElVirtualSpinOffsetZ
El_BarrelAxis
PolariInterpolation
SetGageOffserVar
VirtualZAxisADynamic
VirtualZAxisARotary
XAxisMultiplier

New Functions in V6.2.2

The following new Functions are added for V6.2.2.

ISFILE
NOT

Macros not yet in the documentation

CutterCompOnOffSwitches

Function — CUTTER COMPENSATION
Status — ACTIVE

Valid Inputs — Value, Text

This macro is used to set the flags which determine how to process the turning on and
turning off of Cutter Compensation.

Value: Specifies the option you want for a specific scenario as defined by the Textstr
argument. The valid options are specific to the specific scenario selected. Valid Options
are:

Text=1
Value =1 - Ramp On
Value = 2 = Immediate



Text=2
Value =1 > Ramp On with Active Plane Motion
Value = 2 2 Immediate
Value = 3 - Ramp on with Any Motion
Text=3
Value = 1 > Ramp On with Active Plane Motion
Value = 2 2 Immediate
Value = 3 - Ramp On with Any Motion

Text=11
Value = 1 - Adjust the input coordinates to match the physical location
of the tool
Value = 2 - Do not Adjust the input coordinates to match the physical location
of the tool

Text: Specifies which flag (scenario) to set:
1 = Turning on Cutter Compensation with motion within the plane
2 = Turning on Cutter Compensation with no motion
3 = Turning on Cutter Compensation with the only motion being outside of the plane
11 = Turning off Cutter Compensation

CycleTurnDiameter

Function — TURNING CYCLES
Status — ACTIVE

Valid Inputs — None

Macro CycleTurnDiameter sets the turning cycle type to diameter. The current position
is used as the diameter start point. When X and/or Z words are included on the block they
define the endpoint of the canned diameter. When U and/or W words are included on the
block, the associated U-W values are interpreted as signed incremental values from the
start point to the end point. The XaxislncreMotion and ZaxisIncreMotion macros must
be called when U and W are used to define the canned diameter endpoint.

The CycleTurnDiameter macro is modal until canceled by one of the following macros:
MotionRapid, MotionLinear, MotionCW, MotionCCW, MotionNurbs, MotionPoly,
or Motion3DCircle.

The G90, canned diameter cycle remains active allowing additional blocks of the G90,
cycle to be simulated until canceled by another G-code.

Requires a G90, word address to call the CycleTurnDiameter macro. The associated
CycleTurn* macros DO NOT have to be called for each block.



For example:
G90 X2.5Z-2R0.1
X2.4

X2.3

X2.2

X2.1

X2.0
G00X3.0Z21.0

CycleTurnTaper

Function — TURNING CYCLES
Status — ACTIVE

Valid Inputs — Value

Specifies the distance of taper in X-axis direction for a diameter canned cycle (signed
value, radius).

CycleTurnThreadOff

Function — TURNING CYCLES
Status — ACTIVE

Valid Inputs — Text, Value

The macro enables you to define a set of word/value pairs in the OVERRIDE TEXT field
which are used to signify when the turning cycle modal is turned off. For example, the
word/value pairs entered in the OVERRIDE TEXT field might be as follows: "G00, G01,
G02, G03". This provides full control for cancelling turning cycle modals.

El_BarrelAxis

Function — TAPE LAYING
Status — ACTIVE

Valid Inputs — Text

Text = Name of the Rotary component which defines the barrel axis

This macro is specific to an EI tape laying machine. It is passed the name of the rotary
component which defines the barrel axis. Based on the Angle and RPM settings in the
NC Programs window (VCS only), it will:

1. Rotate this axis to the angle specified in the NC Programs window
2. Set the Rotary type based on the Speed (Closest Distance, CW, CCW)
3. Set the Speed of this axis.



ElVirtualSpinOffsetY
Function — TAPE LAYING
Status — ACTIVE

Valid Inputs — Value

This macro is specific to an Electroimpact (EI) tape laying machine. This macro specifies
the Y offset from the rotisserie axis to the center of the part. This virtual center point is
only used in calculations when in spinning mode. This macro is mutually exclusive with
ElTapeVirtualAxis. See also EIVirtualSpinOffsetZ

ElVirtualSpinOffsetZ
Function — TAPE LAYING
Status — ACTIVE

Valid Inputs — Value

This macro is specific to an Electroimpact (EI) tape laying machine. This macro specifies
the Z offset from the rotisserie axis to the center of the part. This virtual center point is
only used in calculations when in spinning mode. This macro is mutually exclusive with
ElTapeVirtualAxis. See also EIVirtualSpinOffsetY.

PolarInterpolation

Function — CYLINDRICAL/POLAR
Status — ACTIVE
Valid Inputs — Value

0 = Off
1=0n

Turns on and off polar interpolation. Polar Interpolation is being defined as the capability
to use the PolarLinearAxis and the PolarRotational Axis (by default X and C) macros
to execute a linear or circular move. The input can be either Cartesian coordinates or
Polar coordinates.

EXAMPLES:

Using Cartesian coordinates: X1C1
X calls PolarXValue
C calls PolarYValue

Using Polar Coordinates: X1.4142 C45
X calls XAxisMotion
C calls CAxisMotion

NOTE: The "interpolation” state (None, Polar, or Cylindrical) is supported as a
conditional state, and can be displayed in the Status window.



SetGageOffsetVar
Function — MISC
Status — ACTIVE
Valid Inputs — Text

This macro sets the specified variable (text value) to the current z value of the gage offset
(gage point - driven point).

With a Fanuc control, this macro is called with the H word after GageOffsetDrivenPoint
(which sets the gage point and the driven point based on the TLS file), and called with an
Override Text of: {2000 + $}

VirtualZAxisADynamic
Function — Miscellaneous
Status — Active
Valid Inputs — Value
0=0n
1 = Off

Turns on, and off, the dynamic calling of the VirtualZAxisARotary macro. If the ABC
angles are being calculated from IJK points, then the VirtualZAxisARotary macro needs
to be called after the A angle has been set. This is done by calling this macro. A value of
0 turns this feature on, a value of 1 turns this feature off.

VirtualZAxisARotary
Function — Miscellaneous
Status — Active

Valid Inputs — None

Establish a virtual Z axis using rotation planes. The input angle is defined by the local A-
axis value. The AAxisMotion macro is used to specify incremental/absolute, and must be
called prior to calling this macro. This angle defines the angle at which the real Z-axis is
offset from the virtual orthogonal Z axis.

XAxisMultiplier

Function — MOTION

Status — ACTIVE

Valid Inputs — Multiplier to be applied to the XAxisMotion macro

This macro defines a multiplier that is used by the XAxisMotion macro.



This multiplier is currently only used by the XAxisMotion macro.

Typically, this macro will be called when transitioning between programming in
radius mode and diameter mode.

If you have a .5 multiplier on the X word or the Word/Address entry, then this macro
would be pass a value of 2 when changing to radius mode, and a 1 when changing to
diameter mode.

If you do not have a multiplier on the X word or the Word/Address entry, then this
macro would be pass a value of 1 when changing to radius mode, and a .5 when
changing to diameter mode.

The default value is zero, which means to ignore the multiplier.

NOTE: If a multiplier is defined, and Debug Macro Arguments are turned on, you will

see the following results:
Debug: MACRO: XAxisMotion, WORD: X, TEXTSTR=5., VALUE=5
Debug: ADJUSTED X VALUE=2.5 (XAxisMultiplier)

Functions not yet in the documentation

ISFILE (string)

It is used to check if the specified string refers to an existing file in the system. If file is
found the function returns a 1 (TRUE), otherwise the function returns 0 (FALSE). The
function checks the current working directory, project directory and library trying to find
specified file. The default file extension is MPF. The string argument can contain the file
path if necessary.

NOT value
It is used to check if an argument (value) is equal to 0 and returns 1 (TRUE), otherwise
returns O (FALSE).
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